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Chapter 443

Conditional Power of
Two-Sample T-Tests
for Non-Inferiority
Introduction
In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the
experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to
evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional
power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to
the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power
over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment
techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow
and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).
This program module computes conditional and predictive power for the case when a two-sample t-test is used to
test non-inferiority between two means.

Technical Details
All details and assumptions usually made when using a two-sample non-inferiority t-test continue to be in force
here.

Conditional Power
The power of an experiment indicates whether a study is likely to result in useful results, given the sample size.
Low power means that the study is futile: little chance of statistical significance even though the alternative
hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the
study has started. When this happens, the study is curtailed.
The futility of a study that is underway can be determined by calculating its conditional power: the probability of
statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to
the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional
power will seldom result in study curtailment very early in the study.
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From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage k for
rejecting a null hypothesis about a parameter θ at the end of the study, given the observed test statistic, Z k , is
computed as

 Z I − z1−α I K + θ (I K − I k ) 
,
Puk (θ ) = Φ  k k


I
I
−
K
k


and the general lower one-sided conditional power at stage k is computed as

 − Z k I k − z1−α I K − θ (I K − I k ) 
,
Plk (θ ) = Φ 


IK − Ik


where

θ = the parameter being tested by the hypothesis
k = an interim stage at which the conditional power is computed (k = 1,…, K – 1)
K = the stage at which the study is terminated and the final test computed

Z k = the test statistic calculated from the observed data that has been collected up to stage k
I k = the information level at stage k
I K = the information level at the end of the study

z1−α = the standard normal value for the test with a type I error rate of α.
Let 𝜇𝜇1 and 𝜇𝜇2 be the population means in groups 1 and 2, respectively. If we define 𝛿𝛿 = 𝜇𝜇2 − 𝜇𝜇1 , such that 𝛿𝛿0 is
the non-inferiority difference boundary, 𝛿𝛿1 is the true population difference under the alternative hypothesis, and
𝛿𝛿̂𝑘𝑘 = 𝑥𝑥̅2𝑘𝑘 − 𝑥𝑥̅1𝑘𝑘 is the estimated mean difference from the observed data at stage k, then the parameter 𝜃𝜃 to test
the one-sided non-inferiority alternative hypotheses of 𝐻𝐻1 : 𝛿𝛿 > 𝛿𝛿0 (higher means better) or 𝐻𝐻1 : 𝛿𝛿 < 𝛿𝛿0 (higher
means worse) and other conditional power calculation components as outlined in Chang (2008) page 70 are
𝜃𝜃 = 𝛿𝛿1 − 𝛿𝛿0 (the expected difference under the alternative hypothesis)

𝑍𝑍𝑘𝑘 = �𝛿𝛿̂𝑘𝑘 − 𝛿𝛿0��𝐼𝐼̂𝑘𝑘 (the non-inferiority t-statistic computed from the observed data)

σ 2 σ 2 
I k =  1 + 2 
 n1k n 2 k 

−1

σ 2 σ 2 
I K =  1 + 2 
 n1 n2 

(the interim information level)

−1

(the final information level)

where

Iˆk is the estimated information from the sample at stage k

n jk is the sample size in group j at stage k
n j is the final sample size in group j

σ 2j is the variance of group j
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Computing conditional power requires you to set 𝛿𝛿0, 𝛿𝛿1, σ 1 , and σ 2 , in addition to the current test statistic
value, 𝑍𝑍𝑘𝑘 . Their values can come from the values used during the planning of the study, from similar studies, or
from estimates made from the data that has emerged.

Futility Index
The futility index is 1 − 𝑃𝑃𝑘𝑘 (𝜃𝜃)|𝐻𝐻1. The study may be stopped if this index is above 0.8 or 0.9 (that is, if
conditional power falls below 0.2 or 0.1).

Predictive Power
Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution
of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power
at stage k is given by

 Z I − z1−α I k 
,
Puk = Φ  k K


I
I
−
K
k


and the general lower one-sided predictive power at stage k is given by

 − Z k I K − z1−α I k 
,
Plk = Φ 


I
I
−
K
k


with all terms defined as in the equations for conditional power.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Test
Higher Means Are
Use this option to specify the direction of the non-inferiority test. If Higher Means are “Better”, the alternative
hypothesis is H1: δ > δ0, with δ0 < 0. If Higher Means are “Worse”, the alternative hypothesis is H1: δ < δ0, with
δ0 > 0.

Alpha
Alpha
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error
occurs when a true null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025
for one-sided tests. You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
N1 (Group 1 Target Sample Size)
Enter one or more values of the target sample size of group 1, the total number of subjects planned for this group.
This value must be an integer greater than one. Note that you may enter a list of values using the syntax
50,100,150,200,250 or 50 to 250 by 50.
N2 (Group 2 Target Sample Size)
Enter a value (or range of values) for the target sample size of group 2 or enter Use R to calculate N2 from N1.
You may enter a range of values such as 10 to 100 by 10.
•

Use R
If Use R is entered here, N2 is calculated using the formula
N2 = [R(N1)]
where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or equal to Y. For
example, if you want N1 = N2, select Use R and set R = 1.

R (Sample Allocation Ratio)
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only used when N2 is
set to Use R.
When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next integer greater than
or equal to Y. Note that setting R = 1.0 forces N2 = N1.
n1k (Group 1 Sample Size at Look k)
Enter the group 1 sample size obtained through look k. If this value is greater than N1, the value of N1 is
increased to this amount.
n2k (Group 2 Sample Size at Look k)
Enter the group 2 sample size obtained through look k. If this value is greater than N2, the value of N2 is
increased to this amount.
Equal Sample Sizes
If n1k is entered here, n2k is set equal to n1k.

Effect Size – Mean Difference
δ0 (Non-Inferiority Difference)
This is the difference bound of the non-inferiority test hypothesis. When Higher Means are “Better”, the
alternative hypothesis is H1: δ > δ0 and you can enter values in the range δ0 < 0 and δ0 < δ1. When Higher
Means are “Worse”, the alternative hypothesis is H1: δ < δ0 and you can enter values in the range δ0 > 0 and δ0 >
δ1.
δ1 (Actual Difference to Detect)
This is the actual difference between the treatment mean and the reference mean at which power is calculated.
For non-inferiority tests, this value is often set to zero. When this value is non-zero, care should be taken that this
value is consistent with the alternative hypothesis.
When Higher Means are “Better”, δ1 > δ0. When Higher Means are “Worse”, δ1 < δ0.
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Effect Size – Standard Deviations
σ1 (Standard Deviation of Group 1)
Enter a value for σ1, the standard deviation of group 1. This value is controversial. Some think you should enter
the value used in planning the study. Others think you should use the value estimated from the data obtained so
far. Still others think you should use a confidence limit for σ1 created from the current sample.
You can enter a range of values such as 1 2 3 or 1 to 5 by 1.
Press the σ button to the right to load the Standard Deviation Estimator window.
σ2 (Standard Deviation of Group 2)
Enter a value for σ2, the standard deviation of group 2. This value is controversial. Some think you should enter
the value used in planning the study. Others think you should use the value estimated from the data obtained so
far. Still others think you should use a confidence limit for σ1 created from the current sample.
You can enter a range of values such as 1 2 3 or 1 to 5 by 1.
Equal Variance
Enter ‘σ1’ to set σ2 = σ1.

Effect Size – Current Test Statistic
Zk (Current Test Statistic)
Enter the value of the T-statistic calculated from the data that have been obtained so far. The test statistic is
calculated as
Zk = (xbar_2k - xbar_1k - δ0) × √[Îk]
where xbar_1k and xbar_2k are the group 1 and group 2 sample means observed at stage k, respectively, and Îk is
the information estimate at stage k.
Zk may be positive or negative. Usually, Zk ranges between -5 and 5.
The conditional power calculations used here are for large samples which are at least 20.
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Example 1 – Computing Conditional Power
Suppose a study has been planned and is to be analyzed using a one-sided non-inferiority t-test against a lower
difference bound of δ0 = -1 at an alpha of 0.025. The sample size is 60. The standard deviations are expected to
be about 4. An interim analysis is run after half the data have been collected. This analysis yields a t-test value of
2.12. The data monitoring board would like to have the conditional power calculated for mean changes, δ1 = μ2 μ1, of -0.5, 0, 0.5, 1, and 1.5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Conditional Power of Two-Sample T-Tests for Non-Inferiority procedure window by
expanding Means, then Two Independent Means, then clicking on Conditional Power, and then clicking on
Conditional Power of Two-Sample T-Tests for Non-Inferiority. You may make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Higher Means Are ................................... Better (H1: δ > δ0)
Alpha ....................................................... 0.025
N1 (Group 1 Target Sample Size) .......... 60
N2 (Group 2 Target Sample Size) .......... Use R
R (Sample Allocation Ratio) ................... 1.0
n1k (Group 1 Sample Size at Look k)..... 30
n2k (Group 2 Sample Size at Look k)..... n1k
δ0 (Non-Inferiority Difference) ................ -1
δ1 (Actual Difference to Detect) ............. -0.5 0 0.5 1 1.5
σ1 (Standard Deviation of Group 1) ....... 4
σ2 (Standard Deviation of Group 2) ....... σ1
Zk (Current Test Statistic) ....................... 2.12

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample T-Test ────────────────────────────────────────────
Hypotheses: H0: δ ≤ δ0 vs. H1: δ > δ0

Cond
Power
0.43342
0.62417
0.78831
0.90055
0.96154

Pred
Power
0.85040
0.85040
0.85040
0.85040
0.85040

Total
Sample
Sizes
N1|N2
60|60
60|60
60|60
60|60
60|60

Current
Sample
Sizes
n1k|n2k
30|30
30|30
30|30
30|30
30|30

Non-Inf
Diff
δ0
-1.0
-1.0
-1.0
-1.0
-1.0

Actual
Diff
δ1
-0.5
0.0
0.5
1.0
1.5

Std
Dev
σ1|σ2
4.0|4.0
4.0|4.0
4.0|4.0
4.0|4.0
4.0|4.0

Test
Stat
Zk
2.120
2.120
2.120
2.120
2.120

Alpha
0.025
0.025
0.025
0.025
0.025

Futility
0.56658
0.37583
0.21169
0.09945
0.03846

References
Jennison, C., and Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman
& Hall/CRC. New York.
Proschan, M., Lan, K.K.G., Wittes, J.T. 2006. Statistical Monitoring of Clinical Trials. Springer. New York.
Chang, Mark. 2008. Classical and Adaptive Clinical Trial Designs. John Wiley & Sons. Hoboken, New Jersey.
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Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the
data that have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the
effect size.
N1|N2 are the anticipated total sample sizes of groups 1 and 2, respectively.
n1k|n2k are the sample sizes of groups 1 and 2, respectively, obtained through stage k.
δ = μ2 - μ1 is the mean difference.
δ0 is the non-inferiority difference used to construct the hypotheses.
δ1 is the actual difference to detect under the alternative hypothesis at which conditional power is
calculated.
σ1|σ2 are the standard deviations of groups 1 and 2, respectively.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be
stopped because there is little chance of achieving statistical significance.
Summary Statements
The first 30 of 60 subjects in group 1 and 30 of 60 subjects in group 2 achieve 43.342%
conditional power to detect a difference of δ1 = -0.5 using a T-test for non-inferiority with a
difference bound of δ0 = -1.0, group 1 standard deviation of σ1 = 4.0, group 2 standard
deviation of σ2 =4.0, and a significance level of alpha = 0.025. The value of the test
statistic from data that have emerged so far is Zk = 2.120. The futility index is 0.56658.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are
given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and δ1.
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Example 2 – Validation
We could not find an example of a conditional power calculation for a one-sided non-inferiority t-test in the
literature. Since the calculations are relatively simple, we will validate the calculation of the first scenario
(θ = δ1 – δ0 = 0.5) of Example 1 by hand.
In this case

I k = (σ 12 / n1k + σ 22 / n2 k )

−1

 16 16 
= + 
 30 30 
= 0.9375

𝑃𝑃𝑢𝑢𝑢𝑢 (𝜃𝜃) = Φ �
= Φ�

−1

I K = (σ 12 / n1 + σ 22 / n 2 )

−1

 16 16 
= + 
 60 60 
= 1.875

−1

𝑍𝑍𝑘𝑘 �𝐼𝐼𝑘𝑘 − 𝑍𝑍1−𝛼𝛼 �𝐼𝐼𝐾𝐾 + 𝜃𝜃(𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘 )
�
�𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘

2.12√0.9375 − 1.9599640√1.875 + 0.5(1.875 − 0.9375)
�
√1.875 − 0.9375

= Φ(−0.1676848)
= 0.4334156

This value matches the first line of the report in Example 1.
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